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Introduction

This tutorial introduces you to the basics of Mastercam Mill-Turn. Mill-Turn is a large 
product with several components, each of which is covered in this tutorial. When you 
have completed the lessons included in this book, you should have the knowledge you 
need to get started with this versatile product.

Tutorial Goals
 Become familiar with the Mill-Turn components.
 Learn the main differences between Mastercam Lathe and Mastercam Mill-

Turn.
 Know the Mill-Turn work flow.
 Explore the contents and use of machine files.
 Understand tool setup and reference positions.
 Setup a Mill-Turn job.
 Create turning and milling toolpaths.
 Use Sync Manager and Machine Simulation effectively.
 Load tools into multi-station tool locators.

Estimated time to complete this tutorial: 8 hours

General Tutorial Requirements
All Mastercam tutorials have the following general requirements:

 You must be comfortable using the Windows® operating system.
 The tutorials cannot be used with Mastercam Demo/Home Learning Edition 

(HLE). The Demo/HLE file format (emcam) is different from the Mastercam file 
format (mcam), and basic Mastercam functions, such as file conversions and 
posting, are unavailable.

 Each lesson in the tutorial builds on the mastery of preceding lesson’s skills. 
We recommend that you complete them in order. 

 Additional files may accompany a tutorial. Unless the tutorial provides specific 
instructions on where to place these files, store them in a folder that can be 



8  MASTERCAM 2017 / Introduction

GETTING STARTED WITH MASTERCAM MILL-TURN

accessed from the Mastercam workstation, either with the tutorial or in any 
location that you prefer.

 You will need an internet connection to view videos that are referenced in the 
tutorials. All videos can be found on our YouTube channel: 
www.youtube.com/user/MastercamTechDocs.

 All Mastercam tutorials require you to configure Mastercam to work in a 
default metric or English configuration. The tutorial provides instructions for 
loading the appropriate configuration file.



CHAPTER 1
1Introduction to Mill-Turn

This book presents an overview of Mastercam Mill-Turn and teaches the basics of 
preparing, simulating, and posting a Mill-Turn part. Along the way, you learn about the 
applications that make up Mill-Turn, including not only Mastercam, but also Code 
Expert.

What is Mastercam Mill-Turn?
Mastercam Mill-Turn is a collection of functions, toolpaths, and applications. These 
Mill-Turn elements work together to create synchronized G-code for cutting parts on a 
multitasking machine.

You begin the Mill-Turn workflow in Mastercam, where you load or create the part to 
cut. You then load a Mill-Turn machine, which adds Mill-Turn operations to 
Mastercam’s interface (see the following picture). These operations include not only 
milling and turning toolpaths, such as facing, pocketing, and pinch-turn, but also part-
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handling operations for programming pickoffs, cutoffs, bar feeds, spindle movement, 
and more.

When you have designed and toolpathed your part, you continue work in Code Expert, 
which is home to Sync Manager, Editor, and Machine Simulation. In Sync Manager you 
synchronize operations, in Editor you edit NC files, and in Machine Simulation, you 
watch your operations in action.

System Requirements
Up-to-date system requirements are available for Mastercam online: 
www.mastercam.com/en-us/Support/System-Requirements.
An internet connection and e-mail access is recommended for support and updates. 
Visit www.mastercam.com for more information.

Getting Ready to Work
Now that you know what Mill-Turn can do, it is time to prepare your materials for the 
remainder of the book.

http://www.mastercam.com/en-us/Support/System-Requirements
http://www.mastercam.com/en-us/Support/System-Requirements
http://www.mastercam.com
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Preparing the Files
1 Place the part files included with this book in a convenient location on your 

hard drive.
2 Place a copy of Generic Fanuc Mill Turn.machine (also included with this 

book) in your C:\Users\Public\Documents\shared mcam2017\Mill 
Turn\machines directory.

Loading a Missing Machine File
Mill-Turn part files store a reference to their machine file. If the machine file is missing 
or moved, Mastercam asks you to reassociate the machine with the part. The following 
procedure shows how to complete this important task. (You do not need to do this 
now. You only need to do this if your part cannot find its machine file.)

1 Open the part file with Mastercam.
The MT Machine File Missing dialog 
box appears, as seen to the right.

2 Click Yes.
The MT Machine Files dialog box 
appears.

3 Navigate to the machine file for your part (in the case of this book, the 
machine file is Generic Fanuc Mill Turn.machine), and select it.
Mastercam loads the machine file and associates it with the part file.

4 Optional : Save the part file under a new name, so that you do not overwrite 
the original.
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How the Book is Organized
This book’s chapters introduce the concepts, applications, and workflow that make up 
Mastercam Mill-Turn. Because the exercises in each chapter are meant to be 
completed in order, we highly recommend that you work through this book from the 
beginning to the end rather than skip from one chapter or tutorial to another.
The following list describes each of this book’s chapters:

 Chapter 1, Introduction to Mill-Turn introduces the Mill-Turn product and 
offers guidelines for using this book.

 Chapter 2, Transitioning to Mill-Turn from Lathe describes the differences 
between Mastercam Mill-Turn and Mastercam Lathe, including network 
issues, file compatibility, and user-interface changes.

 Chapter 3, Workflow Overview is a general road map for successfully working 
with Mastercam Mill-Turn. Topics covered include part geometry, Mill-Turn 
machine solutions, job setup, toolpaths, and more.

 Chapter 4, Working with Machine Files, describes how to install, edit, and 
customize machine files, as well as how to configure Code Expert Editor and 
manage Mill-Turn licenses.

 Chapter 5, Working with Tools and Spindles, explains how to set up tools and 
specify axis combinations.

 Chapter 6, Reference Positions demonstrates how to create and use reference 
positions to specify where to start and end operations.

 Chapter 7, Configuration and Job Setup presents detailed exercises for 
preparing a Mill-Turn part, including specifying a machine and completing job 
setup.

 Chapter 8, Turning Toolpaths features step-by-step procedures for creating 
and synchronizing turning toolpaths and part-handling operations on the left 
and right spindles of your machine.

 Chapter 9, Milling Toolpaths features step-by-step procedures for creating 
and synchronizing milling operations, including facing, pocketing, and 
contour toolpaths.

 Chapter 10, More about Sync Manager provides an overview of Sync 
Manager’s user interface and functionality. This chapter also includes a 
discussion of Sync Manager’s interaction with Mastercam.

 Chapter 11, More about Machine Simulation provides an overview of Machine 
Simulation’s user interface and functionality.
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 Chapter 12, Posting is an overview of Code Expert Editor, including posting, 
editing, and navigating an NC file. This chapter also presents a procedure for 
sending a file to a machine control.

 Appendix A, Loading Multi-Station Tool Locators describes how to load tool 
locators onto a machine’s turrets, as well as load tools into the multi-station 
locators. The complete sample program demonstrates many tool locator and 
tool combinations.
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CHAPTER 2
2Transitioning to Mill-Turn from Lathe

Before you start work with Mill-Turn, you must understand how it differs from pre-X7 
Mastercam. This chapter provides the information you need to begin using Mill-Turn 
effectively.

Running Over a Network
A machine solution (represented by a MACHINE file) includes the post processor and 
other files that Mastercam needs to run Mill-Turn. This means that managing Mill-Turn 
over a network is simplified. Because Mastercam can access the machine file from any 
network location, you can move the file where you wish. You do not need to worry 
about the links between the machine solution’s components.
When you load a Mill-Turn part, Mastercam looks for the machine file and reloads it. If 
the machine solution’s machine file cannot be found—either because it has been 
moved or renamed—you are prompted to find and select it. This interaction is 
different from earlier versions of Mastercam, which do not look for the machine defini-
tion when you load your part, but relies on the copy stored in your part file. Mill-Turn 
requires that your machine file be available whenever you open your part. This ensures 
that if your machine file (or post) has changed, your part will stay up-to-date.

Bringing in Lathe Files
While you can import operations from Lathe parts, the operations require consider-
able modification to function properly. In particular, Lathe miscellaneous operations 
(misc ops) cannot be migrated and should not be imported into your Mill-Turn file. 
This is true even if they were created with the POCO (Pickoff-Cutoff) utility.
If you need to bring parts into Mill-Turn from non-Mill-Turn Mastercam, follow the 
workflow below.
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Importing Parts into Mill-Turn
1 Make a copy of the part file.
2 Open the copy, and delete all of the toolpath groups.

3 Save the file.
4 Select a Mill-Turn machine file.
5 Complete the Job Setup process (see Setting Up Your Job on page 72). 
6 Import operations from your original file, if desired.

CAUTION: Do not import Lathe misc ops.

7 Re-chain geometry as appropriate, and verify all of the settings for each 
operation. Mill-Turn operations are architecturally different from Lathe, so 
you must verify the operation settings.

You must complete the Job Setup process before creating or importing operations. 
For a more detailed example of importing operations, see Importing the Milling Oper-
ations on page 110.

Replacement of Toolpath Parameters that Differ in Mill-Turn
Many options on the Lathe Toolpath parameters dialog box (highlighted in this 
picture) are not present in Mill-Turn:
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The following picture shows the same dialog box in Mill-Turn:

In Mill-Turn, these functions are all machine-specific features that are configured in 
the machine file.

 Coolant options are selected in Sync Manager. Instead of selecting individual 
options, you select strategies that combine several different coolant events. 
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Your machine developer defines these strategies based on options that are 
available on your machine. 

 Mastercam reads home positions from the machine file. You select approach 
and retract strategies in Sync Manager.

 Misc values and canned text do not exist in Mill-Turn. You access machine-
specific options and parameters in Sync Manager.

The following picture shows how coolant appears in Sync Manager. Click the small 
inverted triangle next to each operation or segment to see what options are available. 

Unlike Lathe, where you are limited to 20 miscellaneous ints and reals, Mill-Turn has 
no limit on the number of machine-specific options. Plus, the options can be specific 
to individual operation types or parts of an operation. Also, while the previous misc 
values are limited to numbers, toolpath options in Mill-Turn can be presented as 
numbers, checkboxes, list selections, or strings.

Menu Changes
Mill-Turn organizes the single Toolpaths menu from older versions of Lathe into 
different contextual tabs, as follows:

 The Turning tab contains Lathe operations, including part handling (formerly 
Misc Ops).

 The Milling tab contains 2D, 3D, and Multiaxis Mill operations.
In addition, the Machine Definition Manager and Control Definition Manager are 
disabled. You can access many of their settings in Mill-Turn by opening the machine 
file in Code Expert, and double-clicking Consumer in Machine Explorer.
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Toolpaths Manager Changes
The Toolpaths Manager for Mill-Turn operations has important differences from that 
with non-Mill-Turn operations.

Toolbar Functions
The Tool Setup button on the Toolpaths Manager toolbar is used exclusively by Mill-
Turn, whereas the G1 button has a new function in Mill-Turn:

 The Tool Setup button lets you configure how tools are loaded on your 
machine. 

 The G1 button opens Sync Manager (only in Mill-Turn). From Sync Manager, 
you can create syncs, configure toolpath options, post operations, and launch 
Simulation.
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Machine Group Properties (Files tab)
Some options in the Files tab have been removed for Mill-Turn users, since Mill-Turn 
stores the individual support files in the machine file. 

 Although a default tool library is stored in the machine file, you can still select 
a different one here.

 When creating individual operations, you can always select a tool from any 
library, just like in Mill and Lathe.

 You can also import operations from any library, just like in Mill and Lathe. 
The operations library listed on this tab is only a default selection.

While in non-Mill-Turn Mastercam, you can use the Replace button to select a 
different machine definition, in Mill-Turn you cannot do this. You can, however, use 
the Edit button to make changes to the current machine, if necessary.
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Machine Group Properties (Job Setup tab)
The Job Setup tab is new for Mill-Turn. It replaces the Stock Setup tab from 
Mastercam and is available only in Mill-Turn.

Although the Job Setup tab seems to recreate much of the functionality of the Stock 
Setup tab in Lathe, it is more closely tied to your workflow. 
Follow this general workflow when creating your parts:

1 Create your part geometry. The Mill-Turn workflow proceeds more 
smoothly if you minimize later changes to your part. 

2 Create a solid model of your finished part. A solid model is not required, 
but if you have one, the Machine Simulation and Sync Manager functions 
display it with your toolpaths.
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3 Select your machine file from the Machine tab. The Job Setup function 
launches automatically.

4 Complete the Job Setup pages in the order presented.
When you complete Job Setup, Mastercam automatically creates resources that help 
you program your part. The following list describes these resources.

 A custom WCS—This is a copy of WCS Top, whose origin is located at the 
machine zero location from your machine file.

 New views within the WCS—These views correspond to standard machining 
orientations and applications, for programming both left and right spindles. 
Each view is created with the proper origin and work offset from your Job 
Setup settings. For example, in Job Setup you can choose to locate Z0 at 
either the front face or back face of your part; Mastercam then automatically 
creates tool planes with the desired origin.

 Viewsheets for each spindle—Each viewsheet contains a copy of the part 
geometry properly positioned relative to the chuck jaws.

You learn much more about the individual Job Setup pages when you complete the 
exercises later in this book.

Communications
In Mill-Turn, you use Code Expert to configure your communications settings. 

1 Open Code Expert from your Start menu (Start, All Programs, Mastercam 
2017, Code Expert). If you already have a Mill-Turn machine loaded, Code 
Expert will already be open.

2 Select Options from the File tab.
3 Select Editor, NC, Communications.
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4 Set your options as desired. Use Help to learn more.
Mill-Turn uses the same XML-based configuration files as previous Mastercam 
versions, so if you have been using a customized file, you can use it in Mill-Turn. You 
can also use the same communications program.
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CHAPTER 3
3Workflow Overview

Mastercam Mill-Turn introduces a streamlined workflow for creating the operations to 
cut your part. This chapter presents an overview of this workflow. The following chap-
ters provide more detail and hands-on exercises.
The Mill-Turn workflow comprises the following steps. The remainder of this chapter 
explains each step in more detail.

 Load or create part geometry
 Load the appropriate machine
 Complete job setup
 Create toolpath operations
 Create part handling operations
 Synchronize the operations
 Simulate the operations
 Post the operations

Load or Create Part Geometry
Your first step with Mill-Turn is to create your part’s geometry. Often, this means 
simply loading the part’s file, although you can use Mastercam’s CAD tools to create 
the part’s geometry or to modify an existing part.
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Load the Appropriate Machine
Before you can create Mill-Turn operations on your part, you must load a Mill-Turn 
machine. Choose Machine, Mill-Turn, and then select the machine file you need.
The machine file is a group of files stored as a unit. These files include the machine 
definition, tool database, and other data that non-Mill-Turn Mastercam stores in sepa-
rate files.

Complete Job Setup
When you choose a Mill-Turn machine, Mastercam not only loads the machine, but 
also starts Code Expert, in which you complete many Mill-Turn tasks.
After the machine file and Code Expert load, Mastercam displays the Job Setup tab of 
the Machine Group Properties dialog box. (You can also open Job Setup at any time 
from the Toolpaths Manager, as shown below.) This tab is where you define the 
general parameters for your job. Job Setup arranges these parameters in workflow 
order from top to bottom. The following sections describe each page of parameters.
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WCS Page
Use this page to define your Work Coordinate System (WCS) by clicking the Select 
Named Plane button (circled in the image below) and choosing the initial WCS from 
the Plane Selection dialog box. Use the WCS option when importing geometry that is 
aligned incorrectly for machining, orienting the part on the machine differently from 
how it is oriented in Mastercam. On this page, you can also change the machine 
group’s name, which appears in the Toolpaths Manager.
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Setup Type Page
Use this page to set the spindle on which your job will begin. Here, you also specify 
your stock type (either continuous bar or single piece) and how to handle the parts as 
they are created. Stock type determines which part handling operations—such as pick-
offs, cutoffs, and stock pulls—are available.
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Part Geometry Page
Use this page to select your part geometry and tell Mastercam how to create geom-
etry for the other spindle or for a turn profile. You can also select the color and specify 
the levels on which Mastercam creates the geometry.

If Create Opposed Spindle Geometry is selected, Mill-Turn creates the part geom-
etry in both spindles, as shown in the first of the following pictures. If Create Opposed 
Spindle Geometry is off, Mill-Turn shows the part geometry in only the starting 
spindle, as shown in the second of the following pictures. Having the part geometry in 
both spindles lets you program the part on both the starting and opposing spindles.
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Bar Stock Page
Use this page to select the type of stock and its dimensions. You can also specify the 
number of parts to create and the amount of material to leave for other operations. 
Extra face and back stock are commonly used to leave stock for facing operations and 
affect the part transfer pickoff/cutoff positions.

NOTE: Mill-Turn supports different stock types, with the stock page 
changing depending on your setup type.
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Left and Right Spindle Pages
Use these pages to set chuck parameters for each spindle, including the clamping 
method, chuck dimensions, and part stickout.
The Toolplane origin (on the Toolplane origin Z subpage) sets the zero point for 
operations on each spindle. Mastercam can calculate the value from the part geom-
etry, or you can enter it yourself.
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Pickoff Page
Use this page to set pickoff and cutoff parameters. These include the pickoff location, 
the cutoff tool, and the cutoff width. Note that Mill-Turn uses the cutoff width to 
adjust the pickoff/cutoff positions.
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Finishing Job Setup
When you have finished setting up your job, click OK in Job Setup to finalize your 
choices. Mastercam creates your machine group, plus a set of convenient resources:

 The new WCS
 Viewsheets for each spindle
 Default toolplanes
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The viewsheets, subspindle geometry, and the revolved part profile make it easy for 
you to program operations on the subspindle.
Mastercam creates planes that correspond to standard machining orientations for 
different types of operations in each spindle, with origins keyed to the locations that 
you selected on the Job Setup pages.

Create Toolpath Operations
With job setup completed, you can create the operations to cut your part. Choose 
between turning and milling operations, each tab having its own galleries in 
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Mastercam’s Mill-Turn tab. (Note that this tab appears only when you have loaded a 
Mill-Turn machine file.)

Creating an operation means choosing not only a specific toolpath, such as facing or 
roughing, but also providing information about how your machine will perform the 
operation. For example, as part of the toolpath operation, you choose the cutting tool 
and specify the axis combination (the pairing of a spindle and a turret).
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Create Part-Handling Operations
Next, you tell Mastercam how to handle the part using pickoff and cutoff operations. 
You choose these transfer operations from Mastercam’s Part Handling functions on 
the Turning tab, whose available operations depend on the type of stock you have 
specified. For example, single-piece stock requires only a pickoff, whereas continuous 
bar stock requires a cutoff and a pickoff. The part handling functions also include such 
operations as bar feeds, stock pulls, and turret parking.
Note that part handling operations are not limited to finished parts. They can be used 
for many reasons, including bar feeding, pickoff ops where the opposing spindle 
supports the part, and other custom routines written by the machine solution provider.
The Pickoff, Cutoff, and Stock Pull operations are complete strategies with predefined 
lists of sub-operations, relieving you from having to create these sub-operations one 
by one, although you can modify them as needed. Choosing one of these strategies 
adds a group of operations to Mastercam’s Toolpaths Manager, as seen in the right-
hand picture below.
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NOTE: The resulting operations in the part handling group cannot be 
moved or deleted individually; the entire group must be deleted. This 
restriction allows the machine solution provider to code the post logic to 
handle operations in specific fashions required by the machine tool.

Synchronize the Operations
Sync Manager is a visual tool that creates sync points for multi-stream machines. It 
also helps you create—for both single- and multi-stream machines—custom job 
setups that ensure valid output.

Synchronizing Multi-Stream Jobs
After you have created your operations in Mastercam, run Sync Manager (shown in 
the following picture) from the Toolpaths Manager, and synchronize the operations on 
your machine. Use your mouse to drag-and-drop operations between streams to 
ensure that each can complete successfully without collisions or other problems.

Customizing Settings
Sync Manager provides access to many settings, including coolant strategies, refer-
ence positions, and options traditionally stored as misc values in previous Mastercam 
versions. You can modify these settings by clicking the arrow associated with the 
option to change, and typing the required values into the provided fields.
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.

Simulate the Operations
Use Mill-Turn to simulate the machine’s motions as it cuts your part. By zooming or 
setting the visibility of specific components, you can customize the view to your needs. 
For example, the first picture below shows Machine Simulation’s default display, and 
the second picture shows the same job with the machine housing turned off. 
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Post the Operations
When you have validated your job, you post the operations, which creates the G-code 
that you send to your machine to cut the part. After it is generated, the G-code 
displays in the editor, from which you can access the communications functions 
needed to transmit the code to your machine. 
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CHAPTER 4
4Working with Machine Files

This chapter provides basic information on working with machine files, which drive 
your entire Mill-Turn experience. A Mill-Turn machine file (which has the MACHINE 
extension) differs from the machine and control definition files used in non-Mill-Turn 
Mastercam. To help you understand these differences, this chapter includes the 
following topics:

 Installing your machine file
 Customizing your machine file
 Customizing operation defaults and tool libraries
 Editing machine file settings and defaults
 Configuring Code Expert Editor
 Setting the toolpath directory
 Managing machine licenses

Installing Your Machine File
Your machine file is packaged in a ZIP file with the PDF version of the machine’s appli-
cation guide. Simply unzip the machine file to your desired location. The default loca-
tion is \shared Mcam2017\Mill Turn\MACHINES. However, you can place the 
machine file anywhere you wish.
Unlike non-Mill-Turn Mastercam machines, a Mill-Turn machine file includes all the 
resources needed to support your machine application. That is, the machine file does 
not need to link to other files, such as posts.
To work with your machine file from a network location, copy it to the desired location 
on your network. Since the machine file points to no other files, it works the same from 
a network location or from a local drive.
Note, however, that Mastercam looks for the machine file when you load a part that 
uses it, so the machine file must be in a location to which your workstation regularly 
connects.

NOTE: This guide comes with generic machine files that you can use to 
try Mill-Turn. You will use one of them throughout this tutorial. If you 
wish, you can experiment with the others.
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Customizing Your Machine File
When you load your machine file in Mastercam, Mastercam also loads the machine file 
into Code Expert. When you switch to the Code Expert window and show Machine 
Explorer, you can see the components of your machine file, as described below:

The Control Layers section lists the 
resources the post uses. Most of 
these resources are hidden by the 
post/machine developer. However, 
the Consumer layer contains 
machine defaults and other settings 
that you, as a user, can edit.
The Mastercam Files section lists 
support files that are encapsulated 
inside the your machine file. In non-
Mill-Turn Mastercam, these support 
files are stored throughout your 
Mastercam installation; Mill-Turn 
brings them together inside the 
machine file.
The files in the Mastercam Files 
section are disabled because you 
cannot edit them in Code Expert. 
However, you can edit common files 
such as your operation defaults, 
operation libraries, and tool libraries 
inside Mastercam. To do this, follow 
the guidelines in the next section.

Customizing Operation Defaults and Tool Libraries
You can follow this procedure as needed to customize operation defaults and tool 
libraries. (You do not need to do this as part of the tutorial.)

1 Start Mastercam.
2 Load your machine file or a part that uses the machine file.
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3 In Toolpaths Manager, click the 
Files icon in the Properties section.
The Machine Group Properties 
dialog box opens with the Files tab 
selected.

4 In the Tool Library section, use the 
tool editing buttons to make needed 
tool library changes.

5 In the Operations Library / Defaults File section, use the edit buttons to 
make needed operation and defaults changes.

6 Click the green check to accept your changes and exit the Machine Group 
Properties dialog box.

NOTE: You can also make changes using the Toolpaths Parameters 
page in any operation.

7 Switch to Code Expert and notice 
that your changed file is marked 
with an asterisk in Machine Explorer.

8 In Code Expert, click in Machine Explorer to give it the focus, and then press 
[Ctrl+S] to save your machine changes.

Editing Machine File Settings and Defaults
Your Reseller typically supplies your machine file ready to use. However, you can 
configure many settings according to your preferences and application needs. These 
settings include, but are not limited to, the following:
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 Sequence and sync numbering
 Tool offset numbering
 Use of spaces in your NC file
 Job/shop info for your NC header

To find these settings, open your machine file in Code Expert and double-click the 
Consumer icon in Machine Explorer.

Most of the settings are grouped into two categories:
 Control Definition
 Output Settings

Select a category from the Category drop-down, and then click the + signs to see the 
individual options. (See the following picture.) Some of these options (for example, 
sequence number settings) are common to most controls; others are specific to indi-
vidual machines.
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These settings serve a variety of functions:
 Mimicking the control definition settings in non-Mill-Turn Mastercam
 Configuring toolpath modes and cycles
 Setting default values for Sync Manager and toolpath options

Most of these settings are self-explanatory, and you can easily configure them by 
browsing the interface. After making changes, press [Ctrl+S] to save your machine 
file.

Opening Code Expert in Multi-Stream View
Several settings in the machine file configure Code Expert Editor. Access these options 
by opening the Consumer layer. For example, you can use Code Expert Editor in either 
single-stream or multi-stream mode. To make multi-stream mode the default, do the 
following:

1 Open the Consumer layer.

2 Select the Output Settings 
category.

3 Open the NC Output group.
4 Select the Open post output in Multi-Stream view option.
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Configuring the Find Extents Feature
The Find Extents feature in Code Expert scans your NC file and displays the minimum 
and maximum values for each letter address. By default, Find Extents is set to scan X, Y, 
Z, B, C, S and F. If you wish, you can edit the set of addresses that are scanned.

1 Go to the NC Configuration 
category.

2 Open the Program group.
3 Enter the desired letter addresses in the list, separated by semi-colons ( ; ).

For example, if you add I;J;K; to the list, the next time you post, you will see them in the 
Find Extents table.
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Setting the Toolpath Directory
In non-Mill-Turn Mastercam, the toolpath directory setting is in the Machine Group 
Properties dialog box, as shown below:

In Mill-Turn, the setting in Machine Group Properties is only used to override the 
default toolpath directory. The default toolpath directory (the one used for newly 
created files) is a property of the machine file. To set it, follow these steps:

1 Open the machine file in Code Expert.
2 If necessary, open the Properties window.

3 In Machine Explorer, click the 
machine name.
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4 In Properties, select the desired NC 
output Folder.
Mastercam will write your NC files 
for this machine to this folder.

5 Select the desired Overwrite Mode.
You can choose whether Mastercam 
automatically overwrites NC files 
with the same file name or prompts 
you to enter a different name.

This Overwrite Mode setting 
replaces the setting from the 
Posting dialog box in non-Mill-Turn 
Mastercam.

6 Save the machine file.

NOTE: For more information on your machine’s settings and capabili-
ties with Mill-Turn, please refer to the application guide that comes pack-
aged with each machine. You can also access this document in Machine 
Explorer’s Documentation folder.
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Managing Machine Licenses
Before you can use a Mill-Turn machine, you must have a license for it. If you use other 
Mastercam products, you are familiar with HASPs, the small device that plugs into your 
USB port and verifies your Mastercam license.
Mill-Turn machines, however, use software 
licenses administered by a product named 
CodeMeter. You can access CodeMeter from your 
System Tray, as shown in the picture to the right. 
Use CodeMeter to inspect or manage your Mill-
Turn licenses.

Verifying that You Have the Proper 
License
Follow these steps to see what licenses are avail-
able on your workstation and to verify their 
status:

1 Click the CodeMeter icon in the System Tray.
The CodeMeter Control Center opens. You should see a single item in the 
License tab. This is the container that stores all of the Mill-Turn licenses 
installed on your system. The Status should tell you that the license is 
activated.
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2 Click the WebAdmin button to 
inspect the individual licenses.

Your Web browser opens to the CodeMeter WebAdmin page, as shown in the 
following image.
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3 Click the Licenses tab to see the 
licenses that are installed.

The example below shows two installed licenses, a Mill-Turn Consumer license 
and one license for a machine. If this user had licenses for more machines, the 
additional machines would be listed here.

NOTE: In Mastercam, if you try to open a machine for which you do not 
have a license—or open a part file that uses such a machine—
Mastercam displays an error message.

Reactivating Disabled Licenses
If you have a license installed on your system, and you still receive a license message, 
the license may have become disabled.
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To run properly, the CodeMeter application needs to maintain a constant connection 
with your HASP. If this connection breaks, your software licenses cannot be activated, 
and you will be unable to run Mill-Turn.
Common reasons this might happen include:

 You unplug your HASP before shutting down your workstation.
 You run on a NetHASP, and the network connection is broken.
 Your computer has gone into sleep or hibernation mode, and CodeMeter can 

no longer detect the HASP.
If your CodeMeter licenses are invalid for any reason, the icon in the System Tray 
changes from blue to red. However, you can easily repair the license with CodeMeter. 
Follow these steps:

1 Make sure that your workstation is properly connected to the HASP.
2 Start CodeMeter by clicking its icon in the System Tray.
3 When CodeMeter starts, make sure 

your Mastercam MT license 
container is visible.

CodeMeter should tell you that the license is invalid, as shown in the picture 
for the following step.

4 Click the Repair License button.

You should now be able to run Mill-Turn normally. Please contact your 
Reseller if you still have problems.



CHAPTER 5
5Working with Tools and Spindles

This chapter explains how tool and toolpath settings work together to produce the 
proper NC output for your Mill-Turn machine’s lathe operations and tools. Specifically, 
correct tool use is determined by the following:

 Initial tool setup
 Setting up for left or right spindle

Initial Tool Setup
Tools for both upper and lower turrets should be defined so that they are oriented 
correctly for the intended turret at the tool change position, with the correct vertical or 
horizontal orientation. These settings are stored in the Mastercam tool definition, 
shown below.
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When you first select the tool, it should look as it is oriented at the tool change 
regardless of which spindle you are working on. The position shown in the Toolpath 
parameters page will be different depending on whether the tool is in the B-axis head 
or a lower turret. 

 Editing Tool Settings
To review or edit the tool settings, follow these steps. (This general procedure is infor-
mational only and not part of the tutorial.)

1 Right-click the tool in the tool 
selection window.

2 Choose Edit tool from the pop-up 
menu.
The Define Tool dialog box opens.

3 Click Setup Tool.

The Lathe Tool Setup dialog box opens.
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4 Make changes to the tool settings, as needed.
5 Click OK in the Lathe Tool Setup and Define Tool dialog boxes to finalize 

your changes.

TIP: When altering the tool definition settings, use the Draw Tool button 
to quickly view the tool’s orientation.

Insert Up/Down and LH/RH Holders
When the tool is mounted at the tool change position, it can be in any of four orienta-
tions, depending on whether it is mounted insert up or insert down, and whether you 
are using a left-hand or right-hand holder. Any of these orientations is acceptable with 
Mill-Turn; the correct choice depends on how you need the tool oriented when you 
rotate it into its cutting position.
The tool preview window in Mastercam shows you how the tool is oriented. Notice in 
the following picture that the insert color changes to show insert up (yellow) or insert 
down (orange).

 Changing Insert Orientation
To change the tool from insert up to insert down, do the following. (This general 
procedure is informational only and not part of the tutorial.)

1 Go to the Lathe Tool Setup dialog for the tool. (Click the tool in the 
operation, and then click Setup Tool in the Define Tool dialog box.)

Left-hand holder, insert up

Left-hand holder, insert down

Right-hand holder, insert up

Right-hand holder, insert down
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2 Toggle the Reverse tool setting.
3 Change the Spindle Rotation 

direction.

 Switching Between LH and RH Holders
To switch between left- and right-hand holders, do the following. (This general proce-
dure is informational only and not part of the tutorial.)

1 Go to the Define Tool dialog box. (Click the tool in the operation.)
2 Click the Draw Tool button.
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For your verification, Mastercam 
displays the tool in its current 
configuration.

3 Press [Enter] to return to the Define Tool dialog box.
4 Select the Holders tab.

In the Style box, the holders are 
arranged in left/right pairs.

5 Select the desired left- or right-hand 
holder.

6 Click the Draw Tool button to see 
the change, and then press [Enter] 
to return to the Define Tool dialog 
box.

7 Click Setup Tool.
The Lathe Tool Setup dialog box 
opens.
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8 Change the Spindle Rotation 
setting, and click OK.
The tool positions correctly for the 
operation.

9 Click the Draw Tool button to see 
and verify your change, and then 
press [Enter] to return to the Define 
Tool dialog box.

10 Click OK to dismiss the Define Tool dialog box.

Specifying the Tool’s Compensation Point
Depending on how you set up your tools on the machine, you may need to change 
the compensation point Mastercam uses to calculate the toolpath. Do this in the 
Parameters tab of the Define Tool dialog box, as shown here. If your machine has a 
tool eye (touch setter for turning tools) the standard setting is the first option. 
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If you are using a tool that is being rotated in the B-axis head, and your toolpath is not 
compensated as you expect, use the Cutting Direction options of the Tool Angle 
dialog box (shown below) to specify how your tool was touched off on the machine. 
Click the Tool Angle button on the Toolpath parameters tab to open this dialog box.

NOTE: If you use this compensation method, you must touch off your 
tools differently at the machine.

Selecting the spindle and turret
In Mastercam, to specify which spindle and turret to use, you select an axis combina-
tion. There is a specific axis combination for each possible combination of B-axis head, 
left/right spindle, and turret. Even if your machine has only a B-axis head and left 
spindle, Mastercam defines at least one axis combination.



60  MASTERCAM 2017 / Working with Tools and Spindles

GETTING STARTED WITH MASTERCAM MILL-TURN

 Selecting an Axis Combination
The following general procedure demonstrates multiple axis combos. Follow these 
steps. (This general procedure is informational only and not part of the tutorial.)

1 In the Toolpath parameters tab, click the Axis Combination button.

2 Select the desired turret/spindle 
combination. This picture shows the 
axis combination set to use the 
lower turret on the left spindle.
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Setting Up Tools for Pinch Turning
When creating a pinch turn operation, the settings for the two tools must be correctly 
coordinated. Mastercam cannot create the operation if the settings conflict. Follow 
these guidelines.

 Insert direction—The insert directions for the two tools must be 
complementary. For example, if the upper-turret tool is insert-down, then the 
lower-turret tool needs to be insert-up. You can tell the insert direction from 
the picture in the tool window. An orange insert means insert-down and a 
yellow insert means insert-up.

 Spindle direction—The spindle direction for the two tools must be the same.
 Tool holder—If the above two conditions are met and the toolpath is still not 

created correctly, you might need to select a different tool holder. For 
information on how to do this, please refer to Switching Between LH and RH 
Holders on page 56.
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CHAPTER 6
6Reference Positions

Use reference positions (not to be confused with reference points) to specify where to 
start and end operations. For example, you can move to the tool change position 
between operations by selecting a reference position for the first operation's retract 
and selecting the same reference position for the second operation's starting point.
The following exercises demonstrate how to use and define reference positions in 
your Mill-Turn operations.

Using Reference Positions
Mill-Turn machines come with standard reference positions already defined. You can 
use these predefined reference positions without changing the machine or your part 
files. Just select them as needed in Sync Manager, as the following exercise shows.

1 Load the file CHAP6-PART1 into Mastercam, and save it as CHAP6-PART1-XX, 
where XX is your initials. This ensures that you do not accidentally overwrite 
the original file.

2 Select all operations in Toolpaths 
Manager.

3 Click the G1 button.
Sync Manager opens and displays 
the part’s data.

4 Click the small inverted triangle next 
to operation 1, Lathe Face.
A set of options appears in a drop-
down box. One of these options is 
Reference Position.

5 Open the drop-down menu for the Reference position option, and note that 
it contains only one item, named Lower Reference Return.
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This is the only reference position currently available for this operation on the 
machine’s left spindle, lower turret.

6 Look at the reference position for operation 2, Lathe Rough.
Upper Reference Return is the only reference position currently available for 
this operation on the machine’s left spindle, B-axis head.

7 Look at the reference position for operation 3, Lathe Finish.
You see two reference positions, (None) and Lower Reference Return.

8 Expand the Lathe Finish operation, so that you can see the sub-operations. (If 
you cannot see the “plus” icon for expanding the operation, make sure the 
pane is scrolled all the way to the left.)
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9 On operation 3’s Retract, change the Reference position setting from Lower 
Reference Return to (None).

NOTE: Reference positions are available only on the operation and 
retract nodes in the Operations pane.

10 Save the file.
Saving the file in the Sync Manager 
updates the part in Mastercam.

11 Run Machine Simulation.

12 Use your mouse wheel to zoom in 
on the chuck.
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13 Click Run on the Simulation tab to 
run the simulation, and notice that 
the lower turret does not retract to a 
reference position after completing 
the finish cut.
This is because you set this retract’s 
reference position to (None).

14 In Sync Manager, change the reference position for the third operation’s 
Retract back to Lower Reference Return.

15 Save the file, relaunch Machine Simulation, and click the Run button.
Now, after completing all cuts, the spindle retracts to the position specified by 
the Lower Reference Return reference position.

16 Close Machine Simulation.
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Creating Reference Positions
Although each machine file includes a set of predefined reference positions, you can 
use the main Mastercam application to create your own. You might want a custom 
reference position, for example, to accommodate special part fixtures or tooling. 
Unlike the predefined reference positions, custom reference positions are stored in the 
part file, not the machine file.
The following exercise demonstrates how to define and use a custom reference posi-
tion.

1 In Mastercam’s Toolpaths 
Manager, click the Edit reference 
positions button.
The Machine Reference Position 
Manager opens.

2 Right-click Lower Reference Return, and choose Duplicate selected 
reference position from the pop-up menu.
Mastercam creates a copy of the reference position.

3 Change the new reference position’s name to Alternate Lower Reference 
Return, and set the Z2 Axis value to 500. Click OK to save your changes.
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Now, Alternate Lower Reference Return, the reference point you just 
created, is identical to Lower Reference Return, except for its name and Z2 
Axis value.

4 Click the G1 button to update Sync 
Manager with the new reference 
position.

5 Change the reference position for operation 3’s Retract to the new Alternate 
Lower Reference Return.
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6 Save the file, and run the simulation.
Now the turret retracts to a position 500mm farther to the right, compared to 
where it started at the original Lower Reference Return reference position. 

7 Close Machine Simulation, Code Expert, and Mastercam. 
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CHAPTER 7
7Configuration and Job Setup

Before you create toolpaths with Mastercam Mill-Turn, you must complete configura-
tion and setup tasks. These include choosing a machine and setting the appropriate 
options for your job.

Adding a Machine File
Mill-Turn supports many types of machines, each having its own machine solution 
(MACHINE file). To see how to add a machine, start Mastercam and perform the 
following steps.

Adding Your Machine
1 If you have not already done so, place a copy of Generic Fanuc Mill 

Turn.machine (also included with this book) in your 
C:\Users\Public\Documents\shared mcam2017\Mill Turn\machines 
directory.

2 On Mastercam’s Machine tab, 
choose Mill-Turn, Manage List.
The Machine Definition Menu 
Management dialog box displays. 

3 For the purposes of the exercises in this book, choose Generic Fanuc Mill 
Turn.machine, and click Add.
The machine moves to the Machine Definition Menu Items box, which 
means that it will now appear in Mastercam’s Machine Type, Mill-Turn 
submenu.
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4 Click OK to dismiss the Machine 
Definition Menu Management 
dialog box.

Setting Up Your Job
You can now select the machine from the Machine, Mill-Turn drop-down menu. 
When you do, Job Setup, in which you must define your job’s parameters, displays. 
These parameters include the following:

 The Work Coordinate System (WCS) setting
 The spindle on which work will begin
 The type of work to be done (single piece or bar)
 The part geometry
 The stock definition
 The chuck jaw definitions
 The part stickout and pickoff positions

Selecting a Machine
1 Load the part file CHAP7-PART1, which is included with this book.

NOTE: This part file is in Metric units. If your Mastercam system is set 
for English units, you will be asked about switching from English to 
Metric. Just click OK to proceed.

The part’s geometry displays in Mastercam’s graphics window. However, 
because no machine is assigned to the part, the Toolpaths Manager is empty.
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2 From Mastercam’s Machine, Mill-Turn drop-down menu, choose the 
Generic Fanuc Mill Turn.machine file.

Mastercam creates a new machine group, and then displays the Job Setup tab 
of the Machine Group Properties dialog box.

NOTE: If Code Experts opens on top of Mastercam, minimize Code 
Expert. Do not close it.

Completing Job Setup
The Job Setup tab contains the general parameters for your job. These parameters are 
arranged in top-down fashion, providing a helpful workflow for successfully config-
uring your job. In this section of the book, you work through the parameter list, setting 
up a continuous bar stock job on the left spindle. This job includes pickoff and cutoff 
operations.

Setting WCS, Setup Type, and Stock Type
1 Select the WCS page, and ensure 

that WCS is set to TOP.

NOTE: In your production work, 
you can use the WCS setting to 
reorient parts that are not aligned 
correctly for machining.
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2 Select Setup type in the list, and 
ensure that Initial Spindle is set to 
Left spindle.
The Left spindle setting specifies 
that the job starts on the left spindle. 
If a part transfer is required, the part 
moves from the left spindle to the 
right spindle.

3 Ensure that Continuous bar stock - 
Pickoff, Stock Pull, Cutoff is 
selected in the drop-down list.
Mill-Turn includes options for 
continuous bar stock and single 
stock pieces. Your selection 
determines the part handling 
operations you can create and the 
options that are available in the 
Pickoff page.

Specifying Part Geometry
1 Select Part geometry from the list, 

and click the geometry selection 
arrow.
The dialog box minimizes so that 
you can access Mastercam’s 
graphics window.

2 Click anywhere on the part, and 
press [Enter].
Mastercam returns to the Job Setup 
tab, with the part’s geometry 
selected.
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Mastercam also enables the Delete 
previously created geometry and 
Create Opposed Spindle 
Geometry options. The first ensures 
that geometry created in previous 
operations is removed from the part. 
The second creates geometry for the 
opposite spindle, in this instance, 
the right spindle. 

3 Select the Create turn profile(s) 
option, and ensure that Spin is 
active.
The Create turn profile(s) option 
tells Mastercam to create turn-
profile geometry using either of the 
following methods:

 Spin: Mastercam rotates the part geometry around an axis, generating the 
profile from the farthest extents of the spun geometry.

 Slice: Mastercam slices the part geometry in the Lathe ZX (WCS XY) plane. 
The profile is limited to what the slice encounters and may not include the 
geometry’s full extents. For example, bosses not in the slice plane will be 
unrepresented in the turn profile.

Specifying Bar Stock Settings
1 Select Bar stock in the job setup list, and ensure that Number of parts is set 

to 1.
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2 Set Extra stock for the outside 
diameter to 2.0 mm.

NOTE: The initial stock settings, such as diameter values, appear when 
a solid has been selected as the part or stock model. This is not the case 
with wireframe geometry.

3 Set extra stock for face and back to 
2.0 mm.

Setting Spindle and Chuck Parameters
1 Select Left Spindle, Chuck jaws in 

the job setup list.

2 In the Part Stickout box, click the 
“target” button.
Mastercam minimizes the dialog box 
so that you can access the graphics 
window.

3 Click the part where shown in the following picture.
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The Machine Group Properties dialog box redisplays, and Distance is set to 
145.0.

4 In the job setup list, click Left 
Spindle, Toolplane origin Z.

5 Notice that the toolplane origin is 
on the part’s right face.
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6 In the job setup list, click Right 
Spindle, Toolplane origin Z.

7 Notice that the toolplane origin is 
on the part’s left face.

NOTE: The jaw options that you see are based on the Stock type and 
other stock settings. For example, you will not see ID jaw options unless 
an inner diameter has been specified on the Bar stock page.

Defining the Pickoff Operation
1 In the job setup list, select Pickoff.

2 In the Pickoff box, click the “target” 
button.
Mastercam minimizes the dialog box 
so that you can access the graphics 
window.
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3 Click the part where shown in the following picture.
The Machine Group Properties dialog box redisplays, and Distance from 
chuck face is set to 88.75. This is where the right spindle will grip the part.

4 In the Cutoff box, set Cutoff width 
to 4.0 mm.

5 Click OK to close the Machine Group Properties dialog box.
6 Click OK in the Enter new NC name dialog box.
7 Save the part file as CHAP7-PART2-XX, where XX is your initials.

Your job setup is now complete. In the next chapter, you create the toolpath opera-
tions needed to face the part in the left spindle with the lower turret.
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CHAPTER 8
8Turning Toolpaths

In this lesson, you create toolpaths to cut the face and OD of a part with both 
roughing and finishing operations. You program the initial operations on the left 
spindle. You then transfer the part to the right spindle and cut the areas that were 
inaccessible in the left spindle.
The operations you create are as follows:

 Facing, using the left spindle and lower turret
 Roughing, using the left spindle and upper turret
 Finishing, using the left spindle and lower turret
 Part transfer from the left spindle to the right spindle, which includes pickoff 

and cutoff operations
 Facing, using the right spindle and lower turret
 Pinch Turn, using the right spindle, upper turret, and lower turret

Programming the Left Spindle
In this section, you create a facing toolpath. You also create roughing and finishing 
operations for the part’s OD. You program these toolpaths on the left spindle, alter-
nating between the lower and upper turrets.
Continue with your part from the previous chapter.

The Facing Toolpath
1 Click Mastercam’s Turning tab, and 

choose Face from the General 
toolpaths.
The Lathe Face dialog box appears. 
The tools displayed, however, are 
not appropriate for the operation 
you will create.
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2 Click the Axis Combination button.
The Axis Combination / Spindle 
Origin dialog box displays.

3 Select the Lower Left axis 
combination, and click OK.
The Lathe Face dialog box now 
shows tools that are appropriate for 
the lower-left axis combination.

4 Select the ROUGH FACE LEFT - 80 
DEG tool (your tool may be in a 
different position than the one 
shown).

5 Click the Face parameters tab.
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6 Ensure that Finish Z is set to 0.0, and activate the Lead In/Out checkbox.

7 Click OK to exit the dialog box.
Mastercam creates the facing 
toolpath based on your selected 
parameters, and the operation 
appears in Toolpaths Manager.

The Roughing Toolpath
1 Choose Rough from the General 

toolpaths.
The Chaining dialog box displays.
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2 Select the chain shown in the picture below, by clicking points 1 and 2.

3 Click OK to close the Chaining 
dialog box.
The Lathe Rough dialog box 
displays.

4 Click the Axis Combination button, 
ensure that the Upper Left axis 
combination is selected, and click 
OK.

5 Choose the OD Left 55 deg tool.
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6 Click the Tool Angle button.

7 In the Tool Angle dialog box, set 
the angle to 90, and click OK.

8 Click OK to close the Lathe Rough 
dialog box.

Mastercam creates the roughing toolpath, as shown below.
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The Finishing Toolpath
1 Choose Finish from the General 

toolpaths.
The Chaining dialog box displays.

2 Select the chain shown in the picture below, clicking points 1 and 2.

3 Click OK to close the Chaining 
dialog box.
The Lathe Finish dialog box 
displays.

4 Ensure that the Axis Combination is 
set to Left Spindle / Lower Turret.
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5 Select the OD FINISH RIGHT - 35 
DEG tool.

6 Click OK to close the Lathe Finish dialog box.
Mastercam creates the finishing toolpath.

7 Save the file as CHAP8-PART2-XX, where XX is your initials.

Simulating the Toolpaths
To test your operations, you will now simulate the job in the Machine Simulation 
application.

1 In Mastercam’s Toolpaths Manager, 
click Machine Group-1.
Mastercam selects all of the 
operations.

2 Click the G1 (Post) button.
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After a few moments, Code Expert displays Sync Manager, as shown in the 
picture below. (If you see the Properties pane, close it to free up space in the 
window.)

3 In the Sync Manager tab, click the 
Launch button.
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After a few moments, the Machine Simulation window displays, as shown in 
the picture below.

4 In the graphics window, place your 
mouse pointer over the left spindle, 
and use your mouse wheel to zoom 
in closer to the part’s stock, as 
shown in the picture to the right.
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5 In the Simulation tab, click the Run 
button.

6 Watch as Machine Simulation 
simulates the three operations you 
created. Notice how the machine 
tries to make two cuts 
simultaneously, as seen in the 
picture to the right.

NOTE: Use the Simulation Run 
Speed slider to speed up or slow 
down the simulation as needed.

Synchronizing the Toolpaths
1 Close Machine Simulation.

You are now ready to do more work 
in Sync Manager.

2 In Sync Manager, click the plus signs 
(+) next to the operations in both 
the upper and lower streams.
Sync Manager expands the 
operations to display the sub-
operations.
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3 Drag the right-hand edge of the Operations pane to the right, expanding the 
pane until you can see more of the operations’ descriptions, as shown below.

4 Drag down the bottom edge of the pane, expanding the pane vertically.

5 Use your mouse to drag-and-drop the Lathe Face operation’s Retract to the 
Lathe Rough operation’s Approach.
You have now synchronized the end of the facing toolpath with the start of 
the roughing toolpath. Sync Manager labels the sync point as Sync 1.
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6 Drag the Lathe Rough operation’s Retract to the Lathe Finish operation’s 
Approach.
Sync Manager labels the second sync point as Sync 2.

You have now synchronized the end of the roughing toolpath with the start of 
the finishing toolpath. Your upper and lower streams should now look like the 
following picture.



PROGRAMMING THE LEFT SPINDLE   93

GETTING STARTED WITH MASTERCAM MILL-TURN

TIP: At this point, the file’s 
status icon is yellow, which 
means that Mastercam must 
be updated from Sync 
Manager. For more informa-
tion on how Sync Manager and Mastercam share data, please see Sync 
Manager and Mastercam Interactions (page 130). 

7 Choose File, Save.
Sync Manager writes the synchronized data back to Mastercam, and the 
status icon returns to green.

8 Click the Launch button, and run the simulation again.
Now the operations are synchronized. That is, they are guaranteed to run in 
the correct order, without one operation overlapping another.

9 Close Machine Simulation.
10 Back in Mastercam (not Sync Manager), save the part as CHAP8-PART3-XX, 

where XX is your initials.
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NOTE: Although you can close Code Expert when not using it, we 
suggest that you leave it open for your entire session. Then you do not 
need to wait for it to reload when you next need it.

The Part Handling Operations
You now must transfer the part from the left spindle to the right, so that you can 
create the toolpaths to complete the job. To do this, you program pickoff, cutoff, or 
transfer operations that leave the part clamped in the right chuck, ready for cutting.

Creating Part Handling Operations
1 From Mastercam’s Turning tab, 

choose Part Handling, Pickoff/
Cutoff.
The Pickoff, Stock Pull, Cutoff 
dialog box displays.

2 Verify that the Strategy is set to Pickoff, Stock Pull, Cutoff (Upper Turret), as 
shown in the picture below.
The Strategy selection (A) determines which operations appear in the 
Operations list (B).



THE PART HANDLING OPERATIONS   95

GETTING STARTED WITH MASTERCAM MILL-TURN

3 Click OK to accept the default 
settings for your part handling 
strategy.

Mastercam Mill-Turn creates the 
requested set of operations, as seen 
in the picture to the right.

Simulating the New Operations
1 In Toolpaths Manager, click 

Machine Group-1.
Mastercam selects all of the 
operations.

2 Click the G1 button.
Mastercam sends the new data to 
Sync Manager, and Sync Manager 
displays in Code Expert’s window.

3 Sync operation 4 Turret Park, Lower Park Left to operation 5 Lathe Point, 
Approach, as shown in the picture below.
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Sync Manager creates a sync point labeled Sync 3. You have now 
synchronized the end of the finishing operation with the right spindle 
approach.

4 Save the file back to Mastercam, and 
then click the Launch button.
In a few moments, Machine 
Simulation displays.

5 Rotate the graphics window so that you can see both spindles. (See the 
picture below.) To do this, place your mouse pointer over the graphics 
window, hold down your left mouse button, and drag the mouse.

6 Use your mouse to zoom in on the two spindles.
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Now you can see the simulation more clearly.

7 Click the Run button.

Machine Simulation begins to simulate the job’s operations, but there is a 
collision between the right spindle and the lower turret, as shown below.
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8 If the Collision detected dialog box 
opens, click Yes To All.
Machine Simulation will now ignore 
collisions of this type. Later 
operations will fix the problem.

When the simulation completes, the right chuck will be holding the part, as 
seen in the picture below.

9 Close Machine Simulation.
10 In Mastercam, save the part as CHAP8-PART4-XX, where XX is your initials.

Programming the Right Spindle
Your part is now in the right spindle, and you can create the toolpaths to complete the 
part. For the following exercise, continue with your part from the previous section or 
load part CHAP8-PART4 from the files included with this tutorial.

The Facing Toolpath
1 In Mastercam, select the Machine Group-1.Right viewsheet tab.

The graphics window now displays the right spindle.



PROGRAMMING THE RIGHT SPINDLE   99

GETTING STARTED WITH MASTERCAM MILL-TURN

2 From Mastercam’s Turning tab, 
choose General, Face.
The Lathe Face dialog box displays.

3 Click the Axis Combination button.
The Axis Combination / Spindle 
Origin dialog box displays.

4 Select the Lower Right axis 
combination, and click OK.
The Lathe Face dialog box now 
shows tools that are appropriate for 
the lower-right axis combination.

5 Select the Rough Face Right / 80 
Deg tool.



100  MASTERCAM 2017 / Turning Toolpaths

GETTING STARTED WITH MASTERCAM MILL-TURN

6 Click the Face parameters tab.

7 Ensure that the Lead In/Out 
checkbox is selected, and then click 
the Lead In/Out button. 
The Lead In/Out dialog box 
displays.

8 Click the Lead out tab.

9 Change Angle to 180.
The tool will now exit away from the 
part, rather than toward it.

10 Click OK to exit the Lead In/Out dialog box.
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11 Click the Finish Z button.

12 Click the left face of the part, as 
shown in the picture to the right.

13 Click OK to exit the dialog box.
Mastercam creates the facing 
toolpath based on your selected 
parameters, and the operation 
appears in Toolpaths Manager. 
(Your tool numbers may vary.)

The Roughing Toolpath
1 From Mastercam’s Turning tab, 

choose General, Rough.
The Chaining dialog box displays.
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2 Select the chain shown in the picture below, by clicking points 1 and 2.

3 Choose OK to close the Chaining 
dialog box.
The Lathe Rough dialog box 
displays.

4 Click the Axis Combination button.
The Axis Combination / Spindle 
Origin dialog box displays.

5 Ensure that the Upper Right axis 
combination is selected, and click 
OK.
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6 Choose the OD ROUGH RIGHT - 80 
DEG tool.

7 Click the Tool Angle button.
The Tool Angle dialog box appears.

8 Set Tool Angle to 90, and click OK.

9 Click OK to close the Lathe Rough 
dialog box.
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Mastercam creates the roughing toolpath, as shown below.

The Pinch-Turn Toolpath
1 From Mastercam’s Turning tab, 

choose General, Pinch Turn.
The Pinch Turn Associated dialog 
box opens.

2 Click the Axis Combination button.
The Axis Combination / Spindle 
Origin dialog box opens.
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3 Set the Axis Combination to Lower 
Right, and click OK.

4 Choose the OD RIGHT 55 DEG tool.
5 Click the Pinch turn tab.

The Pinch Turn settings appear in 
the dialog box.

6 In the operation list, select the Lathe 
Rough operation in Toolpath 
Group-2.
This is the operation Mastercam will 
use to generate the pair of 
operations that make up the Pinch 
Turn toolpath.

7 Click OK to exit the dialog box.

Mastercam creates the Pinch Turn toolpath.
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8 In Toolpaths Manager. click the Set up tools on the machine button, as 
shown below.
The Tool Setup Manager dialog box opens.

9 In the dialog box, select the Unload tools already loaded on the machine 
option, and then click the Remove and re-load all tools button.

Mastercam ensures that the tool is loaded correctly for the operation.
10 Click OK to close the dialog box.

Synchronizing the Toolpaths
1 In Toolpaths Manager, click Select 

all operations.
Mastercam selects all of the 
operations.

2 Click the G1 button.
After a few moments, Code Expert 
displays Sync Manager with the 
updated part data.

3 In the Upper Stream list, scroll down to operation 18 Turret Park, and click 
the plus (+) to show the sub-operations.

4 In the Lower Stream list, open operation 19 Turret Park.
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5 Drag-and-drop from operation 18 Turret Park, Upper Reference Return to 
operation 19 Turret Park, Lower Reference Return, as shown in the picture 
below.

You have now synchronized the end of the part handling operations with the 
turret park operation.

6 Drag operation 20’s Retract to operation 21’s Approach.

Sync Manager creates the sync point.
7 Choose File, Save.

Sync Manager writes the synchronized data back to Mastercam.
8 Click the Launch button, and run the simulation.
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All operations are synchronized.
9 Close Machine Simulation.

10 Back in Mastercam (not Sync Manager), save the part as CHAP8-PART5-XX, 
where XX is your initials.

11 Close Mastercam and Code Expert.



CHAPTER 9
9Milling Toolpaths

These exercises step through basic C- and Y-axis toolpathing using a partially 
programmed sample file. For simplicity, you import toolpaths from an existing file.

Setting Up the Part
1 Launch Mastercam.
2 Open the file CHAP9-PART1, which is included with this book, and if the 

System Configuration dialog box displays, click OK to switch system units.
In Toolpaths Manager, you can see that four lathe operations are already programmed 
(see the picture below). To start the C- and Y-axis milling examples, you will import 
operations from a sample part.
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Importing the Milling Operations
1 Right-click in Toolpaths Manager, 

and select Import.
The Import Toolpath Operations 
dialog box appears.

2 Click the Select Operations File 
button.

TIP: To see the file when browsing, you must change the file extension 
filter from Mastercam Operation Files to Mastercam Files.

3 Browse to and open the file CHAP9-FIX SYNCS, which is included with this 
book.
The operations contained in the selected file appear in the Import Toolpath 
Operations dialog box.

4 Select operations 5 through 8 (hold 
down [Shift] to select multiple 
items), and click the Import 
Operations button (the one that 
looks like a plus sign).
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5 Close the Import Toolpath 
Operations dialog box by clicking 
Done.

After the import, Toolpaths 
Manager contains the operations 
shown to the right.

6 In your Windows Start menu, go to All Programs, Mastercam 2017, 
Utilities, Advanced Configuration.
The Mastercam Advanced Configuration dialog box opens.

7 Select the Backplot properties page, and disable the Classic Backplot entry, 
as shown in the following picture. Then click OK.
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Mastercam will now backplot and verify with Mastercam Simulator.

Completing the Pocket Operation
1 Click the Parameters icon in 

operation 5.
The 2D Toolpaths - Pocket dialog 
box displays.

2 Verify that the Toolpath Type is set 
to Pocket.

3 Click the Select chains button.
The Chain Manager dialog box 
appears.
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4 Right-click in the dialog box, and 
choose Add chain from the pop-up 
menu.
The Chaining dialog box appears.

5 Chain the rectangle shown to the 
right, and click OK in the Chaining 
and Chain Manager dialog boxes.

6 Select Tool, and then verify that the 
tool is a ½-inch flat endmill.

7 On the Setup page, ensure that Y-Axis Cross and the Upper Left axis 
combination are selected.
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NOTE: Because there is no existing 
toolplane for the selected geometry, 
Mastercam automatically creates the 
proper plane based on the selected 
geometry, the operation orientation, 
and axis combo. The display at the 
bottom of the dialog box tells you the 
name of the new plane.

8 Click OK to close the 2D Toolpaths - Pocket dialog box.
9 Click Regenerate all selected 

operations.
Mastercam regenerates the pocket 
operation.

 10 Select operation 5’s Toolpath icon in 
the Toolpaths Manager.
The Mastercam Simulator window 
opens.

 11 In the Home tab’s Visibility group, 
ensure that Tool and Workpiece are 
selected.
Mastercam Simulator will now show 
the tool and the workpiece in its 
graphics area.

12 On the View tab, click Isometric.
The view changes to the isometric 
orientation. Note that the view in 
Mastercam also changes to 
isometric.
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13 Click the Play button to run 
backplot.
Mastercam backplots the operation, 
as shown in the following picture.

14 Close Machine Simulation.

Completing the Facing Operation
Next, you finish the short wall in back of the pocket.

1 Click operation 6’s Parameters icon.
The 2D Toolpaths - Contour dialog 
box displays.

2 Ensure that Toolpath Type is set to 
Contour.
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1 Click the Select chains button.
Chain Manager appears.

2 Right-click, and choose Add chain.
The Chaining dialog box appears.

3 In the Chaining dialog box, choose 
the Single button, and then select 
the line at the base of the wall, as 
shown in the following picture.

4 Click OK in both the Chaining and Chain Manager dialog boxes.
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5 On the Setup page, select Y-Axis Cross, Upper Left, and Top, as shown 
below. 

6 Click OK to close the 2D Toolpaths - Contour dialog box.
7 Click Regenerate all selected 

operations.
Mastercam regenerates the 
operation.

8 Select operation 6’s Toolpath icon, and backplot the operation in isometric 
view, as shown below.

9 Close Mastercam Simulator.
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Completing the Rough Contour Operation
Next, you rough out the triangular section at the front of the part.

1 Re-chain geometry for operation 7 – Contour (3D) as shown here.

2 Set Toolpath Type to Contour, and for Tool, select the ½-inch flat endmill.
3 On the Setup page, select C-Axis Face and the Upper Left axis combo.
4 Regen the operation, and backplot it.

5 Close Machine Simulation.
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Completing the Finish Contour Operation
You next finish the triangular section at the front of the part.

1 Re-chain geometry for operation 8 – Contour (2D) as shown here. (Select the 
same contour as in the previous rough operation.)

2 Set Toolpath Type to Contour.
3 On the Setup page, select C-Axis Face and the Upper Left axis combo.
4 Click OK to close the 2D Toolpaths - Contour dialog box.
5 Regen the operation, and select backplot it.

6 In Mastercam, save the part as CHAP9-PART2-XX, where XX is your initials.
7 Close the Simulation, Code Expert, and Mastercam windows.
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CHAPTER 10
10More about Sync Manager

Sync Manager lets you create sync points for multi-stream machines and create 
custom job setups that ensure valid output. You have already used Sync Manager in 
previous chapters. This chapter demonstrates additional features you might have not 
yet discovered.
Sync Manager’s window has six main areas. Refer to the following picture as you work 
through the procedures in this chapter.

Ribbon Machine Explorer

Operations pane Properties grid

Graphics window Timeline
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Customizing the Display
You can easily modify Sync Manager’s display to suit your needs. Try the following 
procedure to discover some common features.

1 In Mastercam, load the part file named CHAP10-PART1, which is included with 
this book. Click OK to change units when asked. Mastercam should look 
similar to the following picture.

Notice that Toolpaths Manager contains a machine group for a Generic Fanuc 
MT Machine. Notice also that the toolpath group contains facing, roughing, 
and finishing toolpaths for the part displayed in the graphics window.

2 Click the G1 button.
In a few moments, Sync Manager 
appears in the Code Expert window, 
as shown in the following picture.
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3 If you have Machine Explorer and the Properties grid open, close them so that 
you can see more of the part.

4 Click the small arrow in the 
Timeline’s upper-right corner, and 
choose Auto Hide.
The Timeline minimizes to a tab.
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5 In the Sync Manager tab, experiment with the checkboxes in the Show group 
to toggle display elements on and off.

The picture below shows a portion of the graphics window with the fixtures 
and stock removed from the display.

6 Click the View tab.
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7 Click the Fit button.
The geometry zooms to fit the 
graphics window.

8 Click the view buttons to see the 
part from different angles.
The picture below shows the part in 
Top view.

Customizing Operation Settings
You can set options for individual parameters by clicking small inverted triangles in 
the Operations pane. Try the following procedure to see how this works.
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1 With your mouse, drag the right-
hand edge of the Operations pane 
to increase its width.

2 Click the plus signs (+) next to the operations in the Operations pane.

Sync Manager expands the operations, as shown below.

3 Go to the View tab, and click 
Properties.

The Properties grid appears. The Code Expert window should now look 
similar to the following picture.
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4 Click OD Left 55 deg in the 
Operations pane.

Information about the selected item 
appears in the Properties grid, as 
shown in the picture to the right.
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5 Back in the Operations pane, click 
the small inverted triangle to the 
right of Lathe Rough.
A small box appears into which you 
can enter option values.

6 Change the Coolant value to 
Strategy1, and then click outside of 
the box to accept your change.
The option’s value in the Properties 
grid also changes. You can edit your 
operations in either the Operations 
pane or the Properties grid.

7 Save the file in Sync Manager, and in Mastercam, save the file as CHAP10-
PART2_XX, where XX is your initials.

Using the Timeline
1 Click the Timeline tab in Code 

Expert’s lower-left corner.
The Timeline displays.

2 In the Timeline’s upper-right corner, 
click the pin icon.
The Timeline’s Auto Hide option is 
now off, and the Timeline no longer 
minimizes to a tab.
The Timeline displays the operations 
horizontally instead of vertically, as 
they are displayed in the 
Operations pane.
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3 If necessary, in the Timeline’s lower-
left corner, drag the zoom slider all 
the way to the left.
You should see the three operations 
and two red lines, as shown below. 
(You may need to maximize the Sync 
Manager window.) The red lines are 
the sync points created in the 
Operations pane.

4 Hover your mouse over a sync point in the Timeline.
Sync Manager displays a tooltip for the sync and outlines the equivalent sync 
point in the Operations pane, as shown in the following image.
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5 Close Code Expert, without saving changes you may have made to the file.

Sync Manager and Mastercam Interactions
Because Sync Manager and Mastercam share data, their interactions are tightly 
controlled. When a part is open in both, you can access either application freely only 
when the data in both is up to date.
Mastercam is the master application with respect to Sync Manager; the part data in 
Mastercam represents the current state of the part. Sync Manager uses a working copy 
of that data. When you save data from Sync Manager, you are updating the part file in 
Mastercam. To see how these interactions work, try the following exercise.

Changing Data in Sync Manager
1 Load the file CHAP10-PART4 (provided with this book) into Mastercam.

Mastercam not only loads the part, but also starts the Code Expert 
application, as seen below. Note that Code Expert is not yet displaying data 
for the part you loaded.
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2 In Mastercam’s Toolpaths 
Manager, select all operations, and 
then click the G1 button.

Sync Manager opens the part. At this point, you can access both Mastercam 
and Sync Manager because both applications have a clean operation set.

3 In Sync Manager, notice the green 
circle on the file’s tab.
Green indicates that Mastercam’s 
and Sync Manager’s data sets 
match.

4 In Sync Manager, expand the Lathe Rough and Lathe Face operations, as 
shown below.

NOTE: You can use the Connect Stream List Display button 
(shown to the right) to lock together the lists, operations, and 
sync points so that they remain horizontally aligned.
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5 Right-click on a Sync 1 sync point, 
and choose Delete Sync Group 
from the pop-up menu.
Sync Manager removes the pair of 
sync points.

6 Notice that the status indicator is 
now yellow, which means 
Mastercam’s and Sync Manager’s 
data sets no longer match.

7 Try to select something in the Mastercam window.
Sync Manager retains control, disabling access to Mastercam. You cannot use 
Mastercam because the loaded part does not yet contain the changes you 
made in Sync Manager.

8 In Sync Manager, click the Save 
button.
Sync Manager’s status indicator 
turns green.

9 Try to select something in the Mastercam window.
Sync Manager lets you access Mastercam because its data is now up to date.
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Changing Data in Mastercam
1 In Mastercam, click the Geometry 

icon in the Lathe Rough operation, 
and delete the chain.

Mastercam marks the operation as 
dirty.

2 Notice that Sync Manager’s status 
icon has changed to a lock.
The lock indicates that the changed 
part in Mastercam does not match 
the data in Sync Manager.
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3 Rechain the geometry (select Geometry, right-click in the Chain Manager 
dialog, and choose Add chain), clicking at the points shown below.

4 Click the Regenerate all selected 
operations button.
Mastercam regenerates the 
operation, resolving its dirty state.

5 Select all operations, and then click 
the G1 button.
Mastercam sends the updated part 
data to Sync Manager, whose status 
indicator again shows green.
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6 In Mastercam, select File, New. (Do 
not save changes to the loaded file.)
Sync Manager’s status indicator 
shows red, which indicates that 
Mastercam and Sync Manager are 
no longer linked.

The table below describes Sync Manager’s status icons.

7 Close all windows.

Sync Manager’s data 
matches Mastercam’s 
data.

Sync Manager needs to 
be rerun from Mastercam.

Changes in Sync Manager 
need to be saved.

Sync Manager and 
Mastercam are 
disconnected.
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CHAPTER 11
11More about Machine Simulation

Use Machine Simulation to verify your toolpaths, watching as a graphical representa-
tion of the machine cuts the part. Using Machine Simulation helps you find problems 
before the actual machining. (For more information about Machine Simulation, please 
read the Machine Simulation tutorial, available from your Reseller or the Mastercam 
website.)
The Machine Simulation window has the main areas shown below. Refer to this illus-
tration as you work through the procedures in this chapter.

Quick Access Toolbar Data panes

Ribbon Progress slider

Graphics window
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Starting Machine Simulation
1 In Mastercam, open the file CHAP11-PART1, which is included with this book. 

Then save the file as CHAP11-PART1-XX, where XX is your initials.
Mastercam’s window should look similar to the following picture.

2 In Toolpaths Manager, click the 
Select all operations button.

3 Click the G1 button.
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Sync Manager opens with the part’s data loaded, as shown below. (Note that 
you may or may not see the Machine Explorer and Properties panes, 
depending on the state of the application when you last closed it.)

4 In Sync Manager, click the Launch 
button.
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The Machine Simulation window appears, as shown in the picture below.

NOTE: If you do not see the tabbed panes on the right side of the 
window, you can display them by choosing Docking Panes options from 
the View tab. The following exercises require you to display the Move 
List.

Running a Simulation
1 Place your mouse over the graphics area, and move your mouse wheel.

The view zooms in or out, depending on the direction you spin the wheel.
2 On the Simulation tab, in the Views 

group, click the Fit button.
Machine Simulation zooms the 
graphics window to exactly display 
its contents.
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3 Click the Run button.

Machine Simulation simulates the operations in your part. As it does, the 
Move List displays the running code, as shown below. (If you do not see the 
Move List, choose View, Move List.)

In the Visibility group, click the Machine Housing button.
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The machine housing becomes transparent, as shown in the following picture.

4 Click the Machine Housing button again.
Machine Simulation removes the machine housing from the display.

NOTE: You can choose a specific display 
state (Show, Transparent, or Hide) by clicking 
the small arrow below a component’s button 
and selecting the state from the drop-down 
menu.
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5 In the graphics window, place your mouse pointer over the left spindle, and 
use your mouse wheel to zoom in closer, as shown in the following picture.

6 Drag the simulation speed slider to 
the left, approximately to the 
location shown.
Now when you next start the 
simulation, it will run slower than it 
did the first time.

7 Click the Restart button.
Machine Simulation resets the 
operations to the beginning.

8 Click the Run button.
Machine Simulation simulates the 
operations with your new settings.
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9 Drag the Progress slider at the bottom of the screen to move backward and 
forward through the simulation.

As you drag the slider, notice how the Move List updates to show the current 
operation and move. (If you do not see the slider, increase the size of the 
Progress area.)

10 Close the Machine Simulation window.
You do not need to save the part.
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12Posting

After you have created your operations and verified them in Machine Simulation, you 
are ready to post the part. This process creates the program (G-code) that you send to 
your machine control to cut the part.
When you post a part, Code Expert opens the resulting G-code in its editor. The editor 
window has the main areas shown below. Refer to this illustration as you work through 
the procedures in this chapter.

Quick Access Toolbar Machine Explorer

Ribbon Properties grid

Code pane
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Posting a Part
1 Load the file CHAP12-PART1 into 

Mastercam, and select all operations 
in Toolpaths Manager.

2 Click the G1 button.
Sync Manager opens and displays 
the part’s data.

3 In Sync Manager, click the Post 
button.
Sync Manager processes the part, 
and opens the resulting G-code file 
into Code Expert’s Editor.

Note that the code is merged into a single stream, with the code for both 
turrets shown in the same pane.
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4 In the Utilities group, click Multi-
Stream, and then click OK in the 
dialog box that displays.

Code Expert divides the code into two streams, with the upper turret on the 
left and the lower turret on the right.

Using the Editing Functions
1 Click NC Configuration.

The NC Configuration dialog box 
opens.

2 Click the Block Numbering tab.
The Block Numbering page opens.
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3 Change Starting number and Increment to 10, and click OK.

4 In the Editing group, click Insert 
Block Numbers.

The Editor adds block numbers to 
the code (see the image to the right) 
based on the settings you specified 
in the Block Numbering page.
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5 Click Remove Block Numbers.
The Editor removes the block 
numbers from the code.

6 Click Remove Comments.
The Editor removes all comments 
from the active stream.

7 On your keyboard, press [Ctrl+Z].
The editor undoes the Remove Comments command.

Using the Syncs and Tools Functions
1 Click in the upper turret stream (the 

left-hand stream), and then click 
Remove Comments.
Code Expert removes comments 
from the stream so that the 
following step in this tutorial does 
not find sync codes in non-code 
lines.

2 In the Syncs group, click First.



150  MASTERCAM 2017 / Posting

GETTING STARTED WITH MASTERCAM MILL-TURN

The editor jumps to the first 
synchronization code in the file.

3 Click Next three times.
The editor shows the next 
synchronization code. (In this 
example, you click three times to 
skip past two occurrences of Pn that 
are not actually sync codes.)

4 In the Tools group, click First.
The editor jumps to the first tool 
change in the stream.

Using the Right-Click Menu
1 Highlight a line of code, right-click 

the line, and choose Lowercase 
from the pop-up menu.
The editor changes the selected text 
to lowercase, as shown below.
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2 Right-click anywhere in the code, 
and select Copy File Path.
The editor places the active file’s full 
path into the Clipboard.

3 Place the text cursor where you want to insert the file’s path, and press 
[Ctrl+V] to paste the file path into your code.

Sending the NC Code to Your Control
1 Click the CHAP12-PART1-Machine Group-1.iof tab, and then click the Post 

button to post the part. (If you are asked to save changes, click No.)
Sync Manager regenerates the NC file.

2 Click the File tab.
The file commands display.

3 Click Options.
The Application Options dialog box 
appears.
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4 Open the option group Editor, NC, 
Communications.
The communications options appear 
in the dialog box’s right pane.

5 Set the communications options 
appropriately for your machine 
control. (If you are unsure, leave 
them set to the defaults.)

6 Click OK to close the Application 
Options dialog box.

7 On the NC Functions tab, click the 
Send (not Send File) button.
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Code Expert sends the G-code file to your machine control.

NOTE: For more information on your machine’s settings and capabili-
ties with Mill-Turn, please refer to the application guide that comes pack-
aged with each machine.

8 Close all windows.

Conclusion
Congratulations! You have completed the Getting Started with Mastercam Mill-Turn 
tutorial. Now that you have mastered the skills in this tutorial, explore Mastercam’s 
other features and functions. 
You may be interested in other tutorials that we offer. The Mastercam tutorial series is 
in continual development, and we will add modules as we complete them. Visit our 
website, or select Help, Tutorials from the File tab to see the latest publications.

Mastercam Resources
Enhance your Mastercam experience by using the following resources:

 Mastercam Help—Access Mastercam Help by selecting Help, Contents from 
Mastercam’s File tab or by pressing [Alt+H] on your keyboard. Also, most 
dialog boxes, function panels, and ribbon bars feature a Help button that 
opens Mastercam Help directly to related information. 

 Mastercam Reseller—Your local Mastercam Reseller can help with most 
questions about Mastercam.
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 Technical Support—CNC Software’s Technical Support department (860-875-
5006 or support@mastercam.com) is open Monday through Friday from 8:00 
a.m. to 5:30 p.m. USA Eastern Standard Time.

 Mastercam Tutorials—CNC offers a series of tutorials to help registered users 
become familiar with basic Mastercam features and functions. The Mastercam 
tutorial series is in continual development, with new modules added as we 
complete them. Visit our website, or select Tutorials from the Help menu to 
see the latest publications.

 Mastercam University—CNC Software sponsors Mastercam University, an 
affordable online learning platform that gives you 24/7 access to Mastercam 
training materials. Take advantage of more than 180 videos to master your 
skills at your own pace and help prepare yourself for Mastercam Certification. 
For more information on Mastercam University, please contact your 
Authorized Mastercam Reseller, visit www.mastercamu.com, or email 
training@mastercam.com. 

 Online communities— You can find a wealth of information, including many 
videos, at www.mastercam.com. For tech tips and the latest Mastercam news, 
follow us on Facebook (www.facebook.com/mastercam), Twitter 
(www.twitter.com/mastercam), or Google+ (plus.google.com/+mastercam). 
Visit our YouTube channel to see Mastercam in action (www.youtube.com/
user/MastercamCadCam)!  
Registered users can search for information or ask questions on the 
Mastercam Web forum, forum.mastercam.com, or use the knowledge base at 
kb.mastercam.com. 
To register, select Community, Link Account from the File tab, and follow 
the instructions.

Mastercam Documentation
Mastercam installs the following documents in the \Documentation folder of your 
Mastercam installation:

 What’s New in Mastercam 2017
 Mastercam 2017 Installation Guide
 Mastercam 2017 Administrator Guide

mailto:support@mastercam.com
http://www.mastercamu.com
mailto:training@mastercam.com
http://www.mastercam.com
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://www.youtube.com/user/MastercamCadCam
http://www.youtube.com/user/MastercamCadCam
http://forum.mastercam.com
http://kb.mastercam.com
http://www.facebook.com/mastercam
http://www.twitter.com/mastercam
http://www.youtube.com/user/MastercamCadCam
http://google.com/+mastercam
http://forum.mastercam.com
http://www.mastercamu.com
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 Mastercam 2017 Transition Guide
 Mastercam 2017 Quick Reference Card
 Mastercam 2017 ReadMe

Contact Us
For questions about this or other Mastercam documentation, contact the Technical 
Documentation department by email at techdocs@mastercam.com.

mailto:techdocs@mastercam.com
mailto:techdocs@mastercam.com
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APPENDIX A
1Loading Multi-Station Tool Locators

Mastercam 2017 introduces multi-station tool locators (see images below), which offer 
extensive flexibility for your machine setup. The examples in this appendix provide an 
overview of loading tool locators onto a machine’s turrets, as well as loading tools into 
the locators. The complete sample program demonstrates many tool locator and tool 
combinations.

 Loading the Part and Processing the Toolpaths
1 Copy the machine file Generic Fanuc Mill-Turn TT.machine into your 

C:\Users\Public\Documents\shared Mcam2017\Mill Turn\machines 
folder.
You use this twin turret machine for the exercises that follow.

2 Open the file Multi-Station Locators.
The file is included with this tutorial and contains many operations that 
require tools be loaded into turrets with multi-station tool locators. After 
loading the file, Mastercam should look like the following image:
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3 In Toolpaths Manager, click 
Machine Group-1 to select all of 
the operations.
If you want to see the operations, 
click the plus signs in the list to 
expand each group.

4 Click the Post selected operations 
button.
Mastercam attempts to process the 
operations, but generates tool-
loading errors (see below). These 
errors must be addressed before 
you can continue.
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5 Click the Cancel button to dismiss the IOF Generation Message Log dialog 
box.
The Tool Setup Manager appears, showing the tools that Mastercam loaded 
into the upper and lower turrets.
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6 Right-click the upper turret in the 
Machine tooling setup list, and 
choose Remove all children from 
the menu that appears.
Mastercam removes all tool locators 
and tools from the upper turret.

7 Right-click the lower turret in the Machine tooling setup list, and choose 
Remove all children from the menu that appears.
Mastercam removes all tool locators and tools from the lower turret. Both 
turrets are now empty.

 Loading a Tool Locator and Tool
1 From the Tool Locators pane, drag the 7.076.328 - UT - 4 Station - 20mm 

Cross Turning- HIPM - LPIU - RPIU tool locator to Index 1 on the upper 
turret
Mastercam adds the tool locator to the turret.
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2 In the Machine tooling setup list, right-click the upper turret, and select 
View component and all children.

Mastercam displays the components in the graphics window.
3 Rotate the components to the view 

shown to the right. Note the four 
locations for tools. You load those 
tools in the next steps.

4 Press [Enter] to return to the Tool Setup Manager.
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5 From the Tools in the machine group list, drag the tool T01 - OD ROUGH 
LEFT - 80 DEG to the location Left - Primary - Insert Up.

6 Right-click the upper turret, and choose View component and all children, 
as you did in Step 2.
Mastercam displays the components in the graphics window.

7 Rotate the components so that you can see the tool loaded into the tool 
locator.
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8 Press [Enter] to return to the Tool Setup Manager.

 Loading the Remaining Tools in the Tool Locator
1 From the Tools in the machine group list, drag the tool T01 - OD ROUGH 

RIGHT - 80 DEG to the location Right - Primary - Insert Up.

2 Drag the tool T24 - OD FINISH LEFT - 35 DEG to the location Left - Half 
Index Primary Minus - Insert Up.

3 Drag the tool T24 - OD FINISH RIGHT - 35 DEG to the location Right - Half 
Index Primary Minus - Insert Up.

The tool locator is now fully loaded.
4 Right-click the upper turret, and choose View component and all children.
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5 Rotate the components so that you can see the four tools loaded into the tool 
locator.

6 Press [Enter] to return to the Tool Setup Manager.

 Loading the Second Tool Locator and Live Mill Tools
1 From the Tool Locators pane, drag the 7.077.128 - UT - 2 Station - ER16 

Live Face - Offset Left tool locator to Index 2 on the upper turret.
Mastercam adds the tool locator to the turret.

2 In the Machine tooling setup list, right-click the upper turret, and select 
View component and all children.
Mastercam displays the components in the graphics window.

3 Rotate the components to the view 
shown to the right. Note the new 
tool locator for live tooling.
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4 Press [Enter] to return to the Tool Setup Manager.
5 In the Tools in the machine group list, locate the 8MM FLAT ENDMILL tools.

In the list, these tools’ descriptions look identical.

6 Hover your mouse pointer over the 
first 8MM FLAT ENDMILL.
A tooltip describes this tool’s 
orientation as Face right.

7 Drag the right-facing 8MM FLAT ENDMILL to the location Right - Live Tool.
8 Drag the other 8MM FLAT ENDMILL (left facing) to the location Left - Live 

Tool.
9 In the Machine tooling setup list, right-click the upper turret, and select 

View component and all children.
Mastercam displays the components in the graphics window.
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10 Rotate the components to the view 
shown to the right, and note the two 
live tools for milling.

11 Press [Enter] to return to the Tool Setup Manager.
If you wish, you can continue mounting tool locators and loading tools to complete 
the part file. The picture below shows what components are loaded and where. Alter-
natively, this tutorial includes the completed file, Multi-Station Locators - 
Complete. You can load this file if you wish to continue without loading the remaining 
components yourself.

 Simulating the Operations
Before continuing with this part of the tutorial, you should have all required tools 
loaded in the machine or have loaded the complete file Multi-Station 
Locators - Complete.
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1 If Tool Setup Manager is still open, click the OK button to close it.
2 In Toolpaths Manager, click 

Machine Group-1 to select all of 
the operations.

3 Click the Post selected operations 
button.

Mastercam processes the operations and opens the part in Sync Manager, as 
shown here:
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4 Click the Launch button to start 
Machine Simulation.

5 If necessary, click Machine Housing 
twice to hide the machine’s housing.

6 Rotate the view so that you can easily see the part stock and the turrets.
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7 Click Run to watch the machine cut the part, paying special attention to the 
turrets and their tool locators. As the simulation runs, adjust the view by 
panning, rotating, and zooming so that you can see each operation clearly.
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